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Câu 1: Để tạo danh sách liệt kê có thứ tự, ta chọn nút lệnh 

A. Numbering. B. Bullets. C. Home. D. Insert. 

Câu 2. Để tạo danh sách liệt kê bằng kí hiệu đầu dòng, ta chọn nút lệnh: 

A. Numbering. B. Bullets. C. Layout. D. Insert. 

Câu 3. Để đánh số trang, ta chọn: 

A. Header  B. Footer. C. Text box. D. Page Number. 

Câu 4. Để bỏ đầu trang, ta mở thẻ Insert, chọn nút lệnh Header rồi chọn 

A. Remove Header. B. Remove Footer. C. Remove Page Numbers. D. Remove Page Design. 

Câu 5: Mỗi đơn vị trong danh sách dạng liệt kê được tạo ra khi người dùng nhấn phím? 

A. Space  B. Enter  C. Tabs  D. View 

Câu 6: Vì sao cần đánh số trang: 

A. Để người đọc phân biệt các trang  B. Để cho đẹp 

C. Để người đọc dễ theo dõi   D. Để tăng dung lượng của file 

Câu 7: Nhóm lệnh Header & Footer nằm trong thẻ: 

A. Home  B. Data  C. Insert  D. Help 

Câu 8: Sử dụng danh sách dạng liệt kê giúp: 

A. Tăng chiều dài của văn bản. 

B. Sửa chữa các phần mềm bị lỗi. 

C. Cấu trúc văn bản rõ ràng, mạch lạc, giúp người đọc dễ theo dõi, văn bản có tính thẩm mĩ hơn. 

D. Các trang chiếu đẹp, dễ theo dõi hơn.  

Câu 9: Phát biểu nào sau đây là sai:  

A. Đầu trang, chân trang có thể chứa chữ, hình ảnh, hình vẽ đồ họa và số trang 

B. Nếu nhập nội dung chân trang, đầu trang, sau đó thực hiện chọn mẫu đầu trang, chân trang thì nội dung đã nhập 

sẽ bị mất. 

C. Chỉ có thể đặt số trang ở phần đầu trang hoặc phần thân trang. 

D. Có thể tự thiết kế đầu trang, chân trang hoặc chọn mẫu có sẵn. 

Câu 10: Các thông tin đặt trong phần đầu trang và chân trang có đặc điểm: 

A. Chứa những thông tin quan trọng  B. Tự động xuất hiện ở tất cả các trang 

C. Chứa hình ảnh minh họa   D. Đáp án khác 

Câu 11: Để đánh số trang vào vị trí giữa, dưới trang văn bản thì chọn: 

A. Blank  B. Footer C. Bottom of Page/ Plain Number 2  D. Header 

Câu 12: Các dấu đầu dòng được tự động tạo ra khi? 

A. Thêm chữ mới B. Thêm số mới C. Thêm đoạn văn bản mới D. Đáp án khác 

Câu 13: Số trang thường được đặt ở: 

A. Đầu trang     B. Chân trang 

C. Cả hai đáp án trên đều đúng  D. Cả hai đáp án trên đều sai 

Câu 14: Em có thể cố định một số thông tin cần xuyên suốt cả văn bản bằng cách: 

A. Sử dụng đầu trang và chân trang   B. Đính kèm tệp 

C. Sử dụng hình ảnh     D. Đáp án khác 

Câu 15: Để hoàn thành việc đánh số trang, thêm đầu trang và chân trang chọn: 

A. Close Header and Footer     B. Footer 

C. Bottom of Page/ Plain Number 2  D. Header 

Câu 16: Em hãy chọn những phương án đúng trong các phương án sau: 

A. Đầu trang và chân trang là đoạn văn bản đầu tiên và cuối cùng trong một trang 

B. Đầu trang và chân trang là văn bản hoặc hình ảnh được chèn vào lề trên và lề dưới 

C. Không thể đưa hình ảnh vào đầu trang và chân trang 

D. Thông tin ở phản đầu trang và chân trang thường ngắn gọn và được tự động thêm vào tất cả các trang trong văn 

bản 

  



Câu 17: Thứ tự trong danh sách có thứ tự được tạo và cập nhật tự động khi: 

A. Thêm các đoạn văn bản trong danh sách  B. Bớt các đoạn văn bản trong danh sách 

C. Cả hai đáp án trên đều đúng   D. Cả hai đáp án trên đều sai 

Câu 18: Trong các màu dưới đây, đâu là nhóm màu nóng? 

A. Đỏ, cam, vàng,…    B. Xanh, tím,…. 

C. Trắng, đen, be,…    D. Xanh, vàng, trắng,… 

Câu 19:  Em hãy chọn phương án đúng: 

A. Văn bản trên trang chiếu cần ngắn gọn, súc tích. 

B. Văn bản trên trang chiếu càng chi tiết, đầy đủ càng tốt. 

C. Sử dụng càng nhiều màu sắc cho văn bản trên trang chiếu càng giúp người nghe tập trung. 

D. Sử dụng nhiều loại phông chữ cho văn bản trên trang chiếu sẽ thu hút được sự chú ý của người nghe. 

Câu 20: Điền vào chỗ (…). 

Văn bản trên trang chiếu cần được định dạng sao cho ……………., cỡ chữ hài hòa, hợp lí với …………….. 

Văn bản được định dạng phù hợp giúp đem lại hiệu quả cao trong việc …………….. nội dung trình chiếu. 

A. màu sắc / nội dung / truyền đạt   B. nội dung / màu sắc / truyền đạt 

C. truyền đạt / màu sắc / nội dung   D. màu sắc / truyền đạt / nội dung 

Câu 21: Khi nháy chuột phải vào đối tượng (hình ảnh, hình vẽ hoặc một cụm từ) đang có gắn siêu liên kết, sẽ 

xuất hiện một bảng chọn có các lệnh gì? 

A. Chỉnh sửa hoặc sao chép siêu liên kết. 

B. Thêm hoặc chỉnh sửa siêu liên kết. 

C. Sao chép hoặc huỷ bỏ siêu liên kết. 

D. Chỉnh sửa hoặc huỷ bỏ siêu liên kết. 

Câu 22: Nếu em sử dụng nền trang chiếu màu xanh dương thì nên sử dụng màu chữ gì để làm nổi bật và dễ 

nhìn? 

A. Màu đỏ.  B. Màu cam.  C. Màu trắng.  D. Màu đen. 

Câu 23: Nút lệnh nào dùng để tạo liên kết trong trang chiếu? 

A. Insert/Picture.    B. Insert/Hyperlink.  

C. Animations/Hyperlink.   D. Review/Hyperlink. 

Câu 24: Đâu không phải là tác dụng của việc trình bày trang chiếu? 

A. Tạo ấn tượng, thu hút sự quan tâm. 

B. Người nghe nhanh chóng tiếp nhận được nội dung tóm tắt của trang trình chiếu. 

C. Dễ nhìn, dễ theo dõi. 

D. Tính toán tự động. 

Câu 25: Đâu không phải là đặc điểm của văn bản trên trang chiếu? 

A. Ngắn gọn.     B. Chỉ nêu ý chính. 

C. Màu sắc hài hòa, cỡ chữ cân đối.  D. Tính toán tự động 

Câu 26: Phát biểu nào là sai về sử dụng màu sắc trên trang chiếu? 

A. Cần đảm bảo độ tương phản giữa màu chữ và màu nền. 

B. Các màu nóng thường được sử dụng để làm nổi bật, thu hút sự chú ý của người xem. 

C. Các màu trắng, đen kết hợp với màu nóng hoặc màu lạnh thường tạo sự hài hòa, trang nhã. 

D. Càng sử dụng nhiều màu sắc trên trang chiếu càng tốt. 

Câu 27: Để chọn nội dung thêm vào chân trang chiếu, ta sử dụng thẻ nào: 

A. Date & Time. B. Fixed.  C. Slide number. D. Footer. 

Câu 28: Trong các màu dưới đây, đâu là nhóm màu lạnh? 

A. Đỏ, cam, vàng,… B. Xanh, tím,…. C. Trắng, đen, be,…. D. Tất cả các đáp án 

Câu 29: Đặc điểm của văn bản trên trang chiếu là gì? 

A. Ngắn gọn.     B. Chỉ nêu ý chính. 

C. Màu sắc hài hòa, cỡ chữ cân đối.  D. Cả 3 đáp án trên. 

Câu 30: Để trình chiếu từ trang đầu ta ấn phím sau đây trên bàn phím: 

A. Enter  B. F5  C. Insert  D. Ctrl+F4. 

  



Câu 31: Nội dung trên trang chiếu có thể là: 

A. Văn bản       B. Biểu đồ, ca khúc 

C. Văn bản, hình ảnh, biểu đồ, âm thanh, đoạn phim … D. A và B đều đúng 

Câu 32: Điều cần chú trọng nhất khi sử dụng màu sắc trên trang chiếu là: 

A. Cần chú trọng đảm bảo độ tương phản giữa màu chữ và màu nền. 

B. Càng nhiều màu sắc càng thu hút 

C. Có thể kết hợp ngẫu nhiên màu sắc trên trang chiếu 

D. Không cần chú trọng gì 

Câu 33: Tình huống nào cần sử dụng liên kết trong trang chiếu: 

A. khi đang trình bày bài trình chiếu có thể sẽ cần mở một tài liệu khác để minh họa cụ thể, chi tiết hơn cho nội 

dung trên trang chiếu. 

B.  

Câu 34: Mục đích của việc sử dụng màu sắc trong trang chiếu là: 

A. Giúp thống nhất cỡ chữ cho các mục cùng mức phân cấp. 

B. Làm cho trang chiếu thêm sinh động và hấp dẫn. 

C. Để dễ thêm chú thích, trích dẫn tài liệu tham khảo. 

D. Làm cho trang chiếu dễ tạo liên kết với video hay tài liệu khác. 

Câu 35: Để hủy bỏ liên kết, chọn: 

A. Hyperlink.  B. Edit Hyperlink…  C. Insert  D. Remove Hyperlink. 

 

 

Câu 36: Nút lệnh Create  có chức năng gì? 

A. Tạo bản mẫu.   B. Áp dụng mẫu định dạng cho trang chiếu được chọn. 

C. Chọn ảnh minh họa.  D. Thay đổi thứ tự trang chiếu. 

Câu 37: Khi đang làm việc với PowerPoint, muốn thiết lập mẫu bố trí của trang chiếu, ta sử dụng lệnh: 

A. Insert → Slide Layout   B. View → Slide Layout 

C. Home → Slide Layout   D. File → Slide Layout 

Câu 38: Phát biểu nào sau đây đúng khi phân biệt bản mẫu và mẫu định dạng: 

A. Mẫu định dạng được thiết kế phù hợp với bản mẫu. 

B. Mẫu định dạng được thiết kế sẵn theo chủ đề. Bản mẫu được thiết kế phù hợp với chủ đề trình chiếu. 

C. Bản mẫu được thiết kế sẵn theo chủ đề. Mẫu định dạng được thiết kế phù hợp với chủ đề trình chiếu. 

D. Mẫu định dạng được thiết kế sẵn theo bản mẫu. 

Câu 39: Có mấy bước để sử dụng bản mẫu trong phần mềm trình chiếu? 

A. 4 bước.  B. 5 bước.  C. 6 bước.    D. 7 bước. 

Câu 40: Phần mềm nào có thể tạo ra bản mẫu sử dụng để trình chiếu? 

A. Phần mềm Microsoft Word.  B. Phần mềm Microsoft Excel. 

C. Phần mềm Microsoft PowerPoint.  D. Phần mềm Microsoft Edge. 

Câu 41: Thao tác đúng để tạo bài trình chiếu mới là: 

A. Nháy chuột chọn Design/Themes, Blank Presentation. 

B. Nháy chuột chọn Design/Variants, Blank Presentation 

C. Nháy chuột chọn File/New, chọn Blank Presentation. 

D. Nháy chuột chọn File/New, chọn New Slide. 

Câu 42: Bản mẫu là: 

A. Là bản thiết kế của một hoặc một nhóm các trang chiếu được lưu dưới dạng một tệp có phần mở rộng là .pptx. 

B. Là một trang chiếu có màu sắc, hình ảnh nền, phông chữ, kiểu chữ, cỡ chữ,… được thiết kế sẵn theo chủ đề. 

C. Là người xem có thể xem lại nhiều lần nội dung bài trình chiếu mà không nhất thiết phải có tác giả trực tiếp trình 

bày. 

D. Là một trang tính giúp người dùng tính toán dữ liệu chính xác, nhanh chóng. 

Câu 43: Khi muốn lưu bài trình chiếu dưới dạng tệp video, ta chọn đuôi nào? 

A. *.pdf.  B. *.pptx.  C. *.jpg.   D. *.MP4. 

  



Câu 44: Apply to selected slides là câu lệnh nào? 

A. Mở bản mẫu.   B. Áp dụng mẫu định dạng cho trang chiếu được chọn. 

C. Chọn ảnh minh họa.  D. Thay đổi thứ tự trang chiếu. 

Câu 45: Đang thiết kế giáo án điện tử, trước khi thoát khỏi PowerPoint nếu người sử dụng chưa lưu lại tập 

tin thì máy sẽ hiện một thông báo. Để lưu lại tập tin này ta sẽ kích chuột trái vào nút nào trong bảng thông 

báo này? 

A. Nút Yes  B. Nút No C. Nút Cancel  D. Nút Save 

Câu 46: Bản mẫu có công dụng như nào? 

A. Chứa bố cục, màu sắc, phông chữ, hiệu ứng, kiểu nền,… và cả nội dụng. 

B. Giúp bài trình chiếu có giao diện thống nhất, chuyên nghiệp mà không tốn thời gian. 

C. Gợi ý các nội dung cần có cho bài trình chiếu; có thể chỉnh sửa, chia sẻ, tái sử dụng bản mẫu. 

D. Cả 3 đáp án trên. 

Câu 47: Làm thế nào để lưu bài trình chiếu dưới dạng tệp video: 

A. Mở tệp bài trình chiếu, chọn File/Save As (chọn thư mục lưu tệp). Chọn Save. 

B. Mở tệp bài trình chiếu, chọn File/Save As (chọn thư mục lưu tệp), nháy chuột phải vào mũi tên bên phải ô Save 

as type (chọn *mp4 hoặc *.wmv). Chọn Save. 

C. Mở tệp bài trình chiếu, chọn File/Save As, nháy chuột phải vào mũi tên bên phải ô Save as type (chọn *mp4 

hoặc *.wmv). Chọn Save. 

D. Mở tệp bài trình chiếu, chọn File/Save As (chọn thư mục lưu tệp), nháy chuột phải vào mũi tên bên phải ô Save 

as type (chọn *mp4 hoặc *.wmv). 

Câu hỏi tự luận: 

Câu 1: Bạn Minh phải hoàn thành một bài thuyết trong môn học Lịch sử do thời gian quá gấp bạn Minh 

không có thời gian để thiết kế bố cục bài thuyết trình, Các em có thể đưa cho bạn Lan những gợi ý giúp bạn 

Lan có những thiết kế đẹp, phù hợp mà vẫn đảm bảo về thời gian?  

….………………………………………………………………………………………………………………………  

…………………………………………………………….…………………………………………………………… 

…………………………………………………………….…………………………………………………………… 

…………………………………………………………….…………………………………………………………… 

…………………………………………………………….…………………………………………………………… 

….………………………………………………………………………………………………………………………  

…………………………………………………………….…………………………………………………………… 

….………………………………………………………………………………………………………………………  

…………………………………………………………….…………………………………………………………… 

…………………………………………………………….…………………………………………………………… 

Câu 2: Khi muốn sử dụng bản mẫu để làm một bài thuyết trình trong kinh doanh hoặc trong các cuộc họp, 

hội nghị, em sẽ chọn bản mẫu theo từ khóa nào là phù hợp?  

….………………………………………………………………………………………………………………………  

…………………………………………………………….…………………………………………………………… 

…………………………………………………………….…………………………………………………………… 

…………………………………………………………….…………………………………………………………… 

…………………………………………………………….…………………………………………………………… 

….………………………………………………………………………………………………………………………  

…………………………………………………………….…………………………………………………………… 

….………………………………………………………………………………………………………………………  

…………………………………………………………….…………………………………………………………… 

…………………………………………………………….…………………………………………………………… 

. 

Câu 3: Bạn Minh có một văn bản có 4 trang. Bạn Minh muốn ghi nội dung tên lớp là “Lớp 8A” vào phần 

chân trang. Em hãy nêu các bước thêm nội dung vào phần chân trang giúp bạn Minh.  

 Nếu thêm vào chân trang đầu tiên nội dung “Lớp 8A” thì trang cuối cùng sẽ xuất hiện nội dung gì? 

Bạn Minh Cần thực hiện thao tác đó mấy lần?  



….………………………………………………………………………………………………………………………  

…………………………………………………………….…………………………………………………………… 

…………………………………………………………….…………………………………………………………… 

…………………………………………………………….…………………………………………………………… 

…………………………………………………………….…………………………………………………………… 

….………………………………………………………………………………………………………………………  

…………………………………………………………….…………………………………………………………… 

….………………………………………………………………………………………………………………………  

…………………………………………………………….…………………………………………………………… 

…………………………………………………………….…………………………………………………………… 

 Thực hiện thao tác 1 lần 

Câu 4: Sắp đến sinh nhật của một người bạn, Lan muốn thiết kế 1 album ảnh bằng Powerpoint tặng cho bạn 

của mình. Nhưng do thời gian quá gấp Lan không kịp lên ý tưởng thiết kế. Các em có thể đưa cho bạn Lan 

những gợi ý giúp bạn Lan có những thiết kế đẹp, phù hợp mà vẫn đảm bảo về thời gian.  

….………………………………………………………………………………………………………………………  

…………………………………………………………….…………………………………………………………… 

…………………………………………………………….…………………………………………………………… 

…………………………………………………………….…………………………………………………………… 

…………………………………………………………….…………………………………………………………… 

….………………………………………………………………………………………………………………………  

…………………………………………………………….…………………………………………………………… 

….………………………………………………………………………………………………………………………  

…………………………………………………………….…………………………………………………………… 

…………………………………………………………….…………………………………………………………… 

Câu 5: Bạn Hà sử dụng biểu tượng hình mặt cười trên trang chiếu để liên kết với văn bản mô tả chi tiết về 

“Cấu trúc tim người”. Sau đó, bạn Hà muốn hủy bỏ liên kết trên bạn Hà cần phải thực hiện những thao tác 

nào? Các em hãy ghi lại các thao tác thực hiện giúp bạn Hà: 

…………………………………………………………….…………………………………………………………… 

…………………………………………………………….…………………………………………………………… 

…………………………………………………………….…………………………………………………………… 

…………………………………………………………….…………………………………………………………… 

….………………………………………………………………………………………………………………………  

…………………………………………………………….…………………………………………………………… 

….………………………………………………………………………………………………………………………  

…………………………………………………………….…………………………………………………………… 

…………………………………………………………….…………………………………………………………… 

 


